
บทที ่3 การดาํเนินการวจัิย 
 

3.1 อุปกรณ์ 
 1. แผนท่ีภูมิประเทศของกรมแผนท่ีทหาร มาตราส่วน 1:50,000 ครอบคลุมขอบเขตลุ่มนํ้าเลย 
 2. ขอ้มูลนํ้ าท่ารายวนัของสถานีวดันํ้ าท่าในลุ่มนํ้ าเลย และของสถานีวดันํ้ าท่าท่ีอยู่ใกลเ้คียง
พื้นท่ีโครงการ จาํนวน 5 สถานี 
 3. ขอ้มูลนํ้าฝนรายวนัของสถานีวดันํ้าฝนในพ้ืนท่ีลุ่มนํ้าเลยและพ้ืนท่ีใกลเ้คียง จาํนวน 6 สถานี 
 4. โปรแกรมแบบจาํลองคณิตศาสตร์ iRIC  Version 2.2 
 5. รายละเอียดโครงการตามแผนพฒันาลุ่มนํ้าเลย จงัหวดัเลย 
 6. ขอ้มูลสารสนเทศภูมิศาสตร์ (GIS) ลุ่มนํ้าเลย 
 

3.2 วธีิการ 
ในการศึกษาการลดนํ้าหลากสูงสุดในลุ่มนํ้าเลยโดยใชแ้บบจาํลอง Nays2D  Flood มีขั้นตอนการศึกษา
ดงัน้ี 

 
3.2.1   กาํหนดพืน้ทีศึ่กษา  
ในการศึกษาคร้ังน้ีไดท้าํการศึกษาการไหลของนํ้ าในแม่นํ้ าเลย จงัหวดัเลย  โดยพื้นท่ีท่ีศึกษาไดเ้ลือก
เขตอาํเภอเมืองเลย เน่ืองจากเป็นเขตพื้นท่ีเศรษฐกิจ การคา้ คมนาคม ฯลฯ ตั้งแต่ปากนํ้ าฮวย  กม. 
90+260 บา้นขอนแดง ตาํบลนาอาน อาํเภอภูหลวง จงัหวดัเลย ถึงสถานี KH.58 A กม.77+400 บา้น
ฟากเลย ตาํบลกุดป่อง อาํเภอเมือง จงัหวดัเลย  รวมความยาวลาํนํ้ าประมาณ 12.86 กิโลเมตร ดงัแสดง
ในรูปท่ี 3.1 
 

3.2.2   การรวบรวมและวเิคราะห์ข้อมูลสภาพภูมิอากาศ 
การรวบรวมขอ้มูลเก่ียวกับลกัษณะภูมิอากาศและอุตุนิยมวิทยาท่ีเคยศึกษาในพื้นท่ีโครงการและ
บริเวณใกล้เคียงจากหน่วยงานต่างๆ เช่น กรมชลประทาน กรมทรัพยากรนํ้ า และสํานักงาน
คณะกรรมการพฒันาการเศรษฐกิจสังคมแห่งชาติ เป็นตน้ รวมทั้งการรวบรวมสถิติขอ้มูลภูมิอากาศ 
จากสถานีตรวจวดัอากาศอาํเภอเมือง จังหวดัเลย ของกรมอุตุนิยมวิทยา ขอ้มูลท่ีรวบรวม ได้แก่ 
ปริมาณฝน อุณหภูมิ ทิศทางและความเร็วลม ความช้ืนสัมพทัธ์ ความกดอากาศ การระเหยของนํ้ าและ
การคายระเหย เป็นตน้ แลว้ทาํการวิเคราะห์ขอ้มูลสภาพภูมิอากาศและอุตุนิยมวิทยาจากสถานี
อุตุนิยมวิทยาต่างๆ ท่ีเก่ียวขอ้งในเขตพื้นท่ีโครงการ โดยหาค่าเฉล่ียรายเดือนและรายปี ค่าสูงสุดและ
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ค่าตํ่าสุดรายเดือนและรายปี เช่น การประเมินอตัราการสูญเสียนํ้ าจากการระเหยจากพื้นท่ีอ่างเก็บนํ้ า 
และพ้ืนท่ีชลประทาน มีรายละเอียดดงัน้ี 
 

 
 

รูปที ่3.1  แผนท่ีแสดงขอบเขตพ้ืนท่ีศึกษา 
 
 
 
 

จุดเร่ิมตน้การศึกษา 

จุดส้ินสุดการศึกษา 

แม่นํ้าเลย 

พื้นท่ีลุ่มนํ้าเลย จงัหวดัเลย 
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ข้อมูลสภาพภูมิอากาศทั่วไปบริเวณพื้นท่ี ลุ่มนํ้ า เลย  จังหวัดเลย  ได้รับอิทธิพลจากลมมรสุม
ตะวนัออกเฉียงเหนือ ซ่ึงพดัพาเอาความหนาวเยน็จากประเทศจีนมา ส่งผลให้มีอากาศหนาวเยน็ และ
ลมมรสุมตะวนัตกเฉียงใต ้ลมน้ีจะพดัประจาํในฤดูฝนและเป็นลมท่ีพดัผา่นมหาสมุทรอินเดียจึงทาํให้
เกิดฝนตกชุก ทิศทางและช่วงเวลาการเกิดลมของมรสุมและพายท่ีุพดัเขา้สู่ประเทศไทย ดงัแสดงในรูป
ท่ี 3.2 ทาํใหเ้กิด 3 ฤดูกาลคือ 
 -    ฤดูร้อน : เร่ิมตั้งแต่เดือนมีนาคมถึงเดือนพฤษภาคม ทาํใหมี้อากาศร้อนจดัในเดือนเมษายน
ดว้ยอิทธิพลของลมมรสุมตะวนัตกเฉียงใตอ้าจทาํใหฝ้นตกและมีอุณหภูมิลดลง 
 -    ฤดูฝน : จะเร่ิมกลางเดือนพฤษภาคมถึงเดือนตุลาคม มีการกระจายตวั 2 ช่วง คือ ช่วงแรกตก
ในเดือนพฤษภาคมจนถึงเดือนมิถุนายน เกิดจากอิทธิพลของลมมรสุมตะวนัตกเฉียงใต ้ปริมาณฝนมี
นอ้ยและกระจายตวัไม่สมํ่าเสมอ สาํหรับช่วงหลงัเกิดจากอิทธิพลของพายดีุเปรสชัน่ พายโุซนร้อน
หรือพายไุตฝุ้่ นจะเกิดในช่วงเดือนกรกฎาคมจนถึงเดือนตุลาคม ปริมาณฝนค่อนขา้งมากและมีการ
กระจายตวัสมํ่าเสมอ 
 -    ฤดูหนาว : จะเร่ิมในเดือนพฤศจิกายนจนถึงเดือนกมุภาพนัธ์ เกิดจากอิทธิพลของลมมรสุม
ตะวนัออกเฉียงเหนือ ทาํใหมี้อากาศหนาวเยน็ แหง้แลง้ ช่วงตน้ฤดูหนาวอากาศมีความช้ืนค่อนขา้งสูง 
ซ่ึงอาจทาํใหมี้ฝนตกไดบ้า้งเลก็นอ้ย 
 
การวิเคราะห์สภาพอุตุนิยมวิทยาใชข้อ้มูลจากสถานีตรวจวดัอากาศท่ีอยู่ใกลเ้คียงเป็นตวัแทน ไดแ้ก่ 
สถานีตรวจวดัอากาศอาํเภอเมือง จงัหวดัเลย ของกรมอุตุนิยมวิทยา ตารางท่ี 3.1 แสดงสถิติภูมิอากาศ
ในคาบ 30 ปี ของสถานีตรวจวดัอากาศ อาํเภอเมือง จงัหวดัเลย และรูปท่ี 3.3 (ก)-(ฉ) แสดงการ
กระจายของค่าตวัแปรภูมิอากาศเฉล่ียในบริเวณพื้นท่ีโครงการ มีรายละเอียดดงัน้ี 
 -    อุณหภูมิ : อุณหภูมิเฉล่ียในพ้ืนท่ีมีค่าเท่ากบั 25.5 องศาเซลเซียส อุณหภูมิเฉล่ียในเดือน
เมษายนสูงท่ีสุดเท่ากบั 28.3 องศาเซลเซียส ช่วงอุณหภูมิตํ่าสุดถึงสูงสุดท่ีเคยเกิดข้ึนมีค่าระหว่าง 0.1-
42.6 องศาเซลเซียส โดยอุณหภูมิตํ่าสุดท่ีเคยเกิดข้ึนปรากฏในเดือนธันวาคมถึงเดือนมกราคมและ
อุณหภูมิสูงสุดท่ีเคยเกิดข้ึนปรากฏในเดือนเมษายน 
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รูปที ่3.2  ทิศทางและช่วงเวลาการเกิดลมมรสุมและพายจุรท่ีพดัเขา้สู่ประเทศไทย 
                     (ท่ีมา : The Rainfall of Thailand, 2549 ) 
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ตารางที ่3.1  สถิติภูมิอากาศในคาบ 30 ปี ท่ีสถานีตรวจวดัอากาศ อาํเภอเมือง จงัหวดัเลย 

สถานี     เลย ระดบัของสถานีเหนือระดบัน้ําทะเลปานกลาง 253 เมตร
รหสั       48353 ความสงูของบาโรมเิตอรเ์หนือระดบัน้ําทะเลปานกลาง 254 เมตร
ละตจิดู   17 27 N ความสงูของเทอรโ์มมเิตอรเ์หนือพืน้ดนิ 1.25 เมตร
ลองตจิดู 101 44 E ความสงูของเครื่องวดัลมเหนือพืน้ดนิ 11 เมตร

ความสงูของทีว่ดัน้ําฝน 1 เมตร
ขอ้มลู ม.ค. ก.พ. ม.ีค. เม.ย. พ.ค. ม.ิย. ก.ค. ส.ค. ก.ย. ต.ค. พ.ย. ธ.ค. รายปี

ความกดอากาศ (+ 1000 หรอื  900 มลิลบิาร)์
เฉลีย่ 1014.48 1012.14 1009.79 1007.98 1006.78 1005.16 1005.09 1005.3 1007.99 1011.16 1014.05 1015.94 1009.66
สงูสุด 1028.68 1025.46 1027.05 1021.96 1015.83 1013.32 1013.06 1012.93 1016.63 1022.14 1025.18 1028.38 1028.68
ตํ่าสุด 1002.15 1000.74 998.42 996.57 997.62 994.86 995.45 995.89 997.07 1001.13 1003.59 1003.16 994.86
พสิยัรายวนัเฉลีย่ 6.39 6.74 6.57 5.96 5.03 4.22 4.07 4.16 4.86 5.15 5.41 5.91 5.37
อุณหภมู ิ (องศาเซลเซยีส)
เฉลีย่ 21.5 23.9 26.8 28.3 27.7 27.7 27.4 27 26.3 25.4 23.3 20.8 25.5
เฉลีย่สงูสุด 30 32.6 35 35.7 33.8 33 32.2 31.8 31.5 30.9 29.9 28.8 32.1
เฉลีย่ตํ่าสุด 14.2 16.4 19.6 22.4 23.5 24.1 23.8 23.6 22.9 21.5 18 14.3 20.4
สงูทีสุ่ด 36.1 39.5 41.3 42.6 40.6 38.9 37 36.2 35.8 35.3 35.5 35 42.6
ตํ่าทีสุ่ด 0.1 6.5 9.3 16.6 18.7 21.3 20.5 20 18.6 12.6 5.7 2.2 0.1
ความชืน้สมัพทัธ ์ (%)_
เฉลีย่ 68 63 60 66 76 78 78 80 83 81 75 71 73
เฉลีย่สงูสุด 90 87 85 88 92 91 92 92 95 95 93 92 91
เฉลีย่ตํ่าสุด 39 35 34 42 55 59 60 63 64 60 51 43 50
ตํ่าทีสุ่ด 13 10 9 11 24 31 35 39 33 33 26 15 9
จุดน้ําคา้ง  (องศาเซลเซยีส)
เฉลีย่ 14.3 15.2 17.1 20.4 22.7 23.1 22.9 23 23 21.5 18.1 14.6 19.7
น้ําระเหย  (มม.)
เฉลีย่-ถาด 113.3 124.9 159 168 149.3 134.7 128 115.9 104.9 108.3 102.6 103.9 1512.8
ความครึม้เมฆ (0-10)
เฉลีย่ 2.7 2.6 2.9 4.5 6.6 7.7 8 8.3 7.3 5.8 4.2 3 5.3
ชัว่โมงทีม่แีสงแดด
เฉลีย่ 253.6 238.6 233.7 225.4 203.6 166.6 145.9 136.4 158.3 195.8 210.2 239.5 2407.6
ทศันวสิยั  (กม.)
เวลา  0700 2.7 2.1 2 4.2 7.1 9.3 9.1 8.8 5.4 3.6 3.3 3 5.1
เฉลีย่ 6.6 5 4.1 6.7 10 11.4 11.4 11.1 9.6 8.7 8.3 7.6 8.4
ความเรว็ลม (น๊อต)
ความเรว็ลมเฉลีย่ 1.7 2 2.2 2.3 2 2.1 2.1 2.1 1.6 1.5 1.4 1.6 1.9
ทศิทาง E E S S S W W N N N E N -
ความเรว็ลมสงูสุด 20 38 50 46 43 33 33 34 33 33 20 30 50
ฝน (มม.)
เฉลีย่ 5.9 16.8 41.9 93.5 202.7 174.7 167.4 175.3 219.9 115.5 18.4 5.5 1237.5
จาํนวนวนัทีฝ่นตก 1.3 2.7 5.5 10.6 17.1 17.1 17.9 19.2 19 12 3 0.8 126.2
ฝนสงูทีสุ่ดใน  24 ชม. 19.6 46 57.4 101.2 163.8 110.6 125 148.2 106.5 86.6 62.5 46.1 163.8
จาํนวนวนัทีเ่กดิ
เมฆหมอก 25.1 26.7 28.6 21.6 4.7 0.5 0.2 0.2 2 7 12.5 18.7 147.8
หมอก 9.8 8.2 8 1.2 1.2 0.6 1.4 1.3 7.9 12.5 11.5 11.5 75.1
ลกูเหบ็ 0 0 0 0 0.1 0 0 0 0 0 0 0 0.1
ฟ้าคะนอง 0.3 2.1 6.5 14.2 20.1 13.5 11.5 10.3 13 6.5 0.8 0.2 99
พายุฝน 0.2 0.6 1.9 3 2.6 1.6 1.4 1.5 0.6 0.2 0.1 0.1 13.8
ทีม่า   :   กรมอุตุนิยมวทิยา.

ตารางท่ี 3.1-1 สถิติภมิูอากาศในคาบ 30 ปี (พ.ศ. 2514-2543) ท่ีสถานีตรวจวดัอากาศ อาํเภอเมือง จงัหวดัเลย
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             (ก) อุณหภูมิ                       (ข) ความช้ืนสมัพทัธ์ 

 

 
                            (ค) ความเร็วลม                            (ง) ความคร้ึมของเมฆ 
 

 
                          (จ) ปริมาณการระเหยจากถาด                                      (ฉ) ปริมาณฝน 
 

รูปที ่3.3  การกระจายของตวัแปรภูมิอากาศเฉล่ียรายเดือนท่ีสถานีตรวจวดัอากาศ 
                               อาํเภอเมือง จงัหวดัเลย 

 
 -   ความช้ืนสมัพทัธ์ : ความช้ืนสมัพทัธ์เฉล่ียรายปีมีค่าเท่ากบั 73% โดยค่าความช้ืนสมัพทัธ์
เฉล่ียสูงสุดเท่ากบั 91% และค่าความช้ืนสมัพทัธ์เฉล่ียตํ่าสุดเท่ากบั 50% ซ่ึงความช้ืนสมัพทัธ์ตํ่าสุดท่ี
เคยเกิดข้ึนมีค่าเท่ากบั 9% ในเดือนมีนาคม 
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 -   ปริมาณการระเหย : ปริมาณการระเหยจากถาดวดัมีค่าตํ่าในช่วงฤดูฝนและมีค่าสูงสุดในช่วง
ฤดูร้อนโดยมีค่าปริมาณการระเหยสูงสุดในเดือนเมษายนและค่าปริมาณการระเหยรายปีเฉล่ียเท่ากบั 
1,512.8 มม. 
 -   ความเร็วลม : ในช่วงระหวา่งเดือนมกราคมถึงเดือนกมุภาพนัธ์ ทิศทางลมจะมาจากทิศ
ตะวนัออก ระหวา่งเดือนมีนาคมถึงเดือนพฤษภาคม ทิศทางลมจะมาจากทิศใต ้ระหวา่งเดือนมิถุนายน
ถึงเดือนกรกฎาคม ทิศทางลมจะมาจากทิศตะวนัตก และระหวา่งเดือนสิงหาคมถึงเดือนธนัวาคม
ทิศทางลมส่วนใหญ่จะมาจากทางทิศเหนือ ค่าความเร็วลมเฉล่ีย 1.9 น๊อต ซ่ึงความเร็วลมสูงสุดท่ีเคย
เกิดข้ึนในเดือนมีนาคมมีค่าเท่ากบั 50 น๊อต 
 -   ความคร้ึมเมฆ : ความคร้ึมเมฆรายเดือนเฉล่ียมีค่าระหวา่ง 2.6-8.3 (ใน 10 ส่วนของทอ้งฟ้า) 
ช่วงท่ีมีความคร้ึมเมฆตํ่าท่ีสุดอยูใ่นเดือนกมุภาพนัธ์และสูงท่ีสุดอยูใ่นเดือนสิงหาคม ค่าเฉล่ียทั้งปี
เท่ากบั 5.3 
 
3.2.3   การรวบรวมและวเิคราะห์ข้อมูลอุทกวทิยา 
การรวบรวมขอ้มูลการศึกษาสภาพอุทกวิทยาทั้งในอดีตและปัจจุบนั และวิเคราะห์ลกัษณะ ปริมาณ 
นํ้าฝน ปริมาณนํ้ าท่า อตัราการไหลของนํ้ าท่า ระดบันํ้ า โดยสถานีอุตุนิยมวิทยาและอุทกวิทยาบริเวณ
พื้นท่ีโครงการดงัแสดงในรูปท่ี 3.4 
 
1.   การวเิคราะห์ข้อมูลปริมาณฝน 
สถานีวดันํ้ าฝนท่ีตั้งอยู่บริเวณพื้นท่ีโครงการและใกลเ้คียงจาํนวน 5 สถานี การแผก่ระจายของฝนใน
พื้นท่ีโครงการ จึงค่อนขา้งสมํ่าเสมอ ไม่แตกต่างกนัมากนกั ดงัรูปท่ี 3.5 โดยทัว่ไปพื้นท่ีบริเวณลุ่มนํ้ า
เลยจะมีปริมาณฝนค่อนขา้งมาก โดยมีฝนเฉล่ียรายปีในช่วง 1,500-2,500 มม. ดงัแสดงรายช่ือสถานีวดั
นํ้ าฝน ปริมาณฝนรายปี และรายเดือนของสถานีต่างๆบริเวณพื้นท่ีโครงการในตารางท่ี 3.2  สาํหรับ
ขอ้มูลปริมาณฝนรายเดือนของสถานีต่างๆ แสดงในภาคผนวก ก การแปรผนัของปริมาณนํ้ าฝนราย
เดือนเฉล่ียบริเวณพื้นท่ีโครงการแสดงในรูปท่ี 3.6 (ก) – (ฉ) 
 
 



   40 
 

 
 

รูปที ่3.4  สถานีอุตุอุทกวิทยาบริเวณพื้นท่ีโครงการ 
 
 
 

สัญลกัษณ์ 
 สถานีวดันํ้าฝน 
 สถานีวดันํ้าท่า 
 ลาํนํ้าธรรมชาติ 
 ท่ีตั้งจงัหวดั 
 ท่ีตั้งอาํเภอ 
 ขอบเขตลุ่มนํ้าเลย 
 สถานีอุตุอุทกนิยมวทิยา 
 อ่างเกบ็นํ้าขนาดกลางตามแผนงาน 

อ่างเกบ็นํ้านํ้ าเลย 

อ่างเกบ็นํ้าหว้ยนํ้าทบ 

อ่างเกบ็นํ้าหว้ยนํ้าฮวย 

อ่างเกบ็นํ้าหว้ยนํ้าลาย 
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รูปที ่3.5  เสน้ชั้นปริมาณฝนเฉล่ียรายปี 
 
 
 
 
 
 
 
 

พื้นท่ีลุ่มนํ้าเลย 
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          (ก) สถานี 18013           (ข) สถานี 18042 

 

  (ค) สถานี 18062           (ง) สถานี 18090 
 

 
  (จ) สถานี 18100           (ฉ) สถานี 18130 

 
รูปที ่3.6  การกระจายตวัรายเดือนของสถานีวดันํ้าฝนบริเวณพ้ืนท่ีโครงการในพ้ืนท่ีลุ่มแม่นํ้าเลย 
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2.  การวเิคราะห์ข้อมูลปริมาณนํา้ท่า 
ลุ่มนํ้ าเลย เป็นลุ่มนํ้ าสาขาของแม่นํ้ าโขงโดยมีสถานีวดันํ้ าท่าท่ีอยูใ่กลเ้คียง จาํนวน 5 สถานี คือ สถานี
วดักู่คาํ  (KH.43), บา้นโพนทอง  (KH.77), บา้นนาหลกั  (KH.28A), บา้นฟากนา  (KH.58A) และ บา้น
แก่งบง  (KH.61) สาํหรับรายช่ือ ตาํแหน่งของสถานีวดันํ้ าท่าบริเวณพ้ืนท่ีโครงการ และค่าปริมาณ
นํ้าท่ารายปีเฉล่ีย แสดงในตารางท่ี 3.3 ค่าปริมาณนํ้าท่ารายเดือนของแต่ละสถานีแสดงในภาคผนวก ก  

 
3.2.4   การรวบรวมข้อมูลระดบัสูงเชิงเลข (Digital Elevation Model : DEM)  
ทาํการรวบรวมขอ้มูลระดบัสูงเชิงเลข (Digital Elevation Model : DEM) จากกรมชลประทาน ซ่ึง
ความละเอียดของขอ้มูลกริดขนาด 30 ม. x 30 ม. ต่อจากนั้นไดท้าํการแปลงไฟลก่์อนนาํเขา้ (Import) 
ไปในโปรแกรม iRIC ในรูปแบบนามสกลุของไฟลเ์ป็น *.tpo  ลกัษณะของขอ้มูล DEM ของสภาพภูมิ
ประเทศท่ีแสดงถึงระดบัดินของพื้นท่ีศึกษา แสดงในรูปท่ี 3.7 

 
3.2.5   ข้อมูลรายละเอยีดโครงการตามแผนพฒันาลุ่มนํา้เลย จงัหวดัเลย   
การรวบรวมขอ้มูลรายละเอียดโครงการตามแผนพฒันาลุ่มนํ้ าเลย จงัหวดัเลย  รวบรวมจากการศึกษา
รายงานความเหมาะสม โครงการนํ้ าเลย อาํเภอภูหลวง จงัหวดัเลย ปี พ.ศ. 2535 รายงานการศึกษา
ความเหมาะสม โครงการอ่างเก็บนํ้ าห้วยนํ้ าฮวย  อาํเภอเมือง จังหวดัเลย ปี พ.ศ. 2549  รายงาน
การศึกษาความเหมาะสม โครงการอ่างเก็บนํ้ าห้วยนํ้ าลาย อาํเภอเมือง จงัหวดัเลย ปี พ.ศ. 2549  และ
รายงานการศึกษาความเหมาะสม โครงการอ่างเก็บนํ้ าห้วยนํ้ าทบ อาํเภอวงัสะพุง  จงัหวดัเลย  ปี พ.ศ. 
2549 สรุปขอ้มูลรายละเอียดโครงการตามแผนพฒันาลุ่มนํ้ าเลย จงัหวดัเลย แสดงไวใ้นบทท่ี 2 ขอ้ 2.3  
รายละเอียดโครงการพฒันาลุ่มนํ้าเลย 
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รูปที ่3.7  ขอ้มูลระดบัสูงเชิงเลข (DEM) บริเวณพื้นท่ีโครงการ 
 

3.2.6   การเตรียมข้อมูลเพือ่นําเข้าแบบจาํลอง 

ทาํการจดัเตรียมขอ้มูลเพื่อนาํเขา้แบบจาํลอง ไดแ้ก่ ขอ้มูลทางภูมิศาสตร์ (Geographic data) และการ
วิเคราะห์ปริมาณนํ้ าหลากสูงสุดในพื้นท่ีโครงการ เพื่อใชเ้ป็นขอ้มูลอตัราการไหลเขา้ (Inflow) นาํเขา้
ไปในโปรแกรม iRIC โดยการประเมินปริมาณนํ้ าหลากสูงสุด ในการศึกษาคร้ังน้ีเลือกใชก้ารคาํนวณ
กราฟนํ้ าหลากสูงสุดจากขอ้มูลนํ้ าฝนโดยใช้เทคนิคกราฟหน่ึงหน่วยนํ้ าท่า (Unit Hydrograph 
Technique) มีขั้นตอนการเตรียมขอ้มูลเพื่อนาํเขา้แบบจาํลอง ดงัน้ี 
 
1.   การเตรียมข้อมูลทางภูมิศาสตร์ (Geographic data) 
การเตรียมขอ้มูลทางภูมิศาสตร์ (Geographic data) จากขอ้มูลระดบัสูงเชิงเลข (Digital Elevation 
Model : DEM) จากกรมชลประทาน ซ่ึงความละเอียดของขอ้มูลกริดขนาด 30 ม. x 30 ม. โดยทาํการ
แปลงไฟลก่์อนนาํเขา้ (Import) ไปในโปรแกรม iRIC ในรูปแบบนามสกุลของไฟลเ์ป็น *.tpo ซ่ึงมี
ขั้นตอนในการแปลงไฟลด์งัน้ี 
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   -    ใช ้Global Mapper เปิดไฟล ์ดว้ยคลิกเมนเมนู File >Open Data File(s)… แลว้คลิกท่ีไฟล ์

DEM  ดงัแสดงในรูปท่ี 3.8 
  -   ทาํการ Crop DEM ใน Global Mapper โดยลากเส้นพื้นท่ี (Area) แลว้เอาพื้นท่ีท่ีจะ
ทาํการศึกษา เป็นขอบเขตท่ีจะ crop DEM จะเห็นดงัรูปท่ี 3.9 เป็นสีแดงหนาๆ จะใชเ้สน้น้ีเป็นพื้นท่ีใน
การ crop 
  -   ทาํการ save file ตรงพื้นท่ีท่ีตอ้งการ crop ใชเ้มนูคลิก File > Export Elevation Grid 
Format > Select Export Format > XYZ Grid > Export  Bounds > Draw a  Box … เลือกพื้นท่ีท่ีทาํการ 
Crop DEM ไว ้ แลว้คลิก OK จะไดไ้ฟลใ์นรูปแบบ *.XYZ ดงัรูปท่ี 3.10 

 

 
 

รูปที ่3.8  แสดงขอ้มูล DEM บริเวณพื้นท่ีโครงการดว้ยโปรแกรม Global Mapper  
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รูปที ่3.9  แสดงการ Crop DEM โดยโปรแกรม Global Mapper  
 

 -   ใชโ้ปรแกรม Microsoft Office Excel เปิดไฟลต์ามขอ้ขา้งบน ดว้ยคลิกเมนเมนู File >Open 
File แลว้คลิกท่ีไฟล ์*.XYZ   แลว้ทาํการบนัทึกชนิดของไฟลใ์นรูปแบบ Tab Delimited  โดยแถวแรก
ใหเ้ป็นค่าผลรวมทั้งหมดของชุดขอ้มูล ดงัแสดงในรูปท่ี 3.11  
 -    เปิดไฟลต์ามขอ้ขา้งบนดว้ยโปรแกรม Notepad แลว้ทาํการบนัทึกชนิดของไฟลใ์นรูปแบบ
นามสกลุของไฟลเ์ป็น *.tpo  โดยใหเ้ลือก for save as type เป็น all files ดงัแสดงในรูปท่ี 3.12  
 

3.2.7   การแบ่งพืน้ทีลุ่่มนํา้ย่อย 

ทาํการแบ่งพื้นท่ีลุ่มนํ้ายอ่ยสาํหรับนาํเขา้แบบจาํลอง โดยทาํการแบ่งพื้นท่ีลุ่มนํ้ายอ่ยในแผนท่ีมาตรา
ส่วน 1: 50,000 ของกรมแผนท่ีทหาร ซ่ึงไดแ้บ่งพื้นท่ีลุ่มนํ้าท่ีศึกษาออกเป็น 5 พื้นลุ่มนํ้ายอ่ย ตามรูปท่ี 
3.13 และรูปท่ี 3.14 จากนั้นหาค่าพารามิเตอร์ของลุ่มนํ้ายอ่ย วดัพื้นท่ีลุ่มนํ้ายอ่ย (A) วดัความยาวลาํนํ้ า
สายหลกั (L) วดัความยาวลาํนํ้ าสายหลกัจากศูนยถ่์วงของลุ่มนํ้าถึงจุดออก (LC) และคาํนวณความลาด
ชนัทอ้งนํ้าเฉล่ีย (S) พารามิเตอร์5 พื้นลุ่มนํ้ายอ่ย แสดงตามตารางท่ี 3.4  
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รูปที ่3.10  แสดง Export Elevation Grid Format (*.XYZ )โดยโปรแกรม Global Mapper  
 
 

 
 

รูปที ่3.11  แสดงการใชโ้ปรแกรม Microsoft Office Excel  เปิดไฟล ์*.XYZ 
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รูปที ่3.12  แสดงการบนัทึกชนิดของไฟลใ์นรูปแบบนามสกลุของไฟลเ์ป็น *.tpo 

  
การสร้างกราฟนํ้าหลากสูงสุดจากขอ้มูลพายฝุนสาํหรับจุดพิจารณา โดยอาศยัเทคนิคกราฟหน่ึงหน่วย
นํ้าท่า (Unit  Hydrograph) ในการวิเคราะห์กราฟหน่ึงหน่วยนํ้าท่าทาํโดยวิธีดดัแปลงของ Snyder 
เน่ืองจากจุดท่ีพิจารณาไม่มีขอ้มูลนํ้าท่า  การสร้างกราฟนํ้าท่าจะทาํการวิเคราะห์แบบลุ่มนํ้ารวม โดย
อาศยัขอ้มูลจากสถานีต่างๆท่ีอยูใ่กลเ้คียงจากสถานีวดันํ้าท่าท่ีมีขอ้มูลทาํการคาํนวณกราฟหน่ึงหน่วย
นํ้าท่าของสถานีเหล่านั้น ต่อจากนั้นนาํมาสร้างกราฟหน่ึงหน่วยนํ้าท่าท่ีไม่มีหน่วย (Dimensionless 
Unit  Hydrograph) และการคาํนวณกราฟเฉล่ียของ Dimensionless Unit  Hydrograph ท่ีไดจ้ากสถานี
ต่างๆท่ีมีลกัษณะคลา้ยคลึงกนัเชิงอุทกวิทยานาํมาหาความสมัพนัธ์ในเลขยกกาํลงั ระหวา่งพารามิเตอร์
ของกราฟหน่ึงหน่วยนํ้าท่าและพารามิเตอร์ของลุ่มนํ้า โดยใชส้มการถดถอยดงัต่อไปน้ี 
 
      1)/(1

n
cp SLLaT        (3.1) 
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1
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p
p t

aAq 




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



         (3.2) 
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โดยท่ี  pq  คือ ปริมาณการไหลสูงสุดของกราฟหน่ึงหน่วยนํ้าท่า  
   (ลูกบาศกเ์มตร/วินาที/มิลลิเมตร) 
 pt  คือ เวลาเกิดปริมาณการไหลสูงสุดของกราฟหน่ึงหน่วยนํ้าท่า (ชัว่โมง) 
 A  คือ พื้นท่ีรับนํ้าฝน (ตารางกิโลเมตร) 
  L  คือ ความยาวตามลาํนํ้าสายใหญ่จากจุดออกจนถึงจุดไกลสุดบนสนัปัน-นํ้า  
     (กิโลเมตร) 
  cL  คือ ความยาวตามลาํนํ้าสายใหญ่จากจุดออกจนถึงจุดไกลสุดบนลาํนํ้าท่ี 
    ใกลจุ้ดศูนยถ่์วงของลุ่มนํ้ามากท่ีสุด  (กิโลเมตร) 
 S  คือ ความลาดเทเฉล่ียของลาํนํ้ าสายใหญ่ 
 2121 ,,, nnaa  เป็นค่าสมัประสิทธ์ิรีเกรชชัน่ ซ่ึงจะตอ้งคาํนวณหาจากขอ้มูลท่ีมีอยู ่
    จริงในแต่ละลุ่มนํ้า 
 
ในการศึกษาคร้ังน้ีใชผ้ลการศึกษาจากรายงานการจดัทาํฐานขอ้มูลนํ้าหลากโดยสาํนกับริหารโครงการ 
สาํนกัอุทกวิทยาและบริหารนํ้า กรมชลประทาน ( พ.ศ.2552) ซ่ึงไดศึ้กษาวเิคราะห์ กราฟหน่ึงหน่วย
นํ้าท่าในลุ่มนํ้าโขงซ่ึงเป็นลุ่มนํ้าหลกัของพื้นท่ีท่ีศึกษา โดยใชข้อ้มูลนํ้าท่ารายชัว่โมงท่ีมีการตรวจวดั
จาํนวน 14 สถานี สามารถนาํมาสร้างกราฟความสมัพนัธ์ระหวา่ง pT  และอตัราส่วน SLLc /  
กราฟความสมัพนัธ์ระหวา่ง AQp /  และ pT  และกราฟหน่ึงหน่วยนํ้าท่าท่ีไม่มีหน่วย (Dimensionless 
Unit Hydrograph) ของลุ่มนํ้าโขง แสดงในตารางท่ี 3.5 และรูปท่ี 3.15 ถึง รูปท่ี 3.17  โดยมีสมการ
ถดถอยดงัน้ี 
 

   0.3979
/ 0.2837 SLLT CP       (R2 =   0.6433)     (3.3)

  

   
-1.0008

1
 0.2175/ 










P
P T

AQ      (R2 =   0.7821)       (3.4)
 

 
โดยท่ี   pQ  = ปริมาณการไหลสูงสุดของกราฟหน่ึงหน่วยนํ้าท่าต่อปริมาณฝนรายวนัเฉล่ียใน 
    พื้นท่ีลุ่มนํ้าในช่วงเหตุการณ์ท่ีตอ้งประเมิน (ลูกบาศกเ์มตร/วินาที/มิลลิเมตร) 
 
เม่ือแทนค่าพารามิเตอร์ต่างๆ ไดแ้ก่ SLLA C ,,,  และอตัราส่วน SLLc /  ลงในสมการ (19) และ 
(20) จะไดค่้า pT  และ pQ  ของ 5 พื้นลุ่มนํ้ายอ่ย  จากนั้นนาํค่า pT  และ pQ  ไปประยกุตก์บักราฟหน่ึง
หน่วยนํ้าท่าไม่มีหน่วย เพื่อสร้างกราฟหน่ึงหน่วยนํ้าท่าของ 5 พื้นลุ่มนํ้ายอ่ย  แสดงในรูปท่ี 3.18 (ก) – 
(จ) 
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รูปที ่3.13  แสดงลกัษณะภูมิประเทศและลุ่มนํ้ายอ่ยในพื้นท่ีโครงการ 
 
 
 

ขอบเขตพื้นท่ีศึกษา 

จุดเร่ิมตน้ลาํนํ้าท่ีศึกษา 

ลุ่มนํ้ายอ่ยท่ี1 (LB1) 

ลุ่มนํ้ายอ่ยท่ี2 (LB2) 

ลุ่มนํ้ายอ่ยท่ี3 (LB3) 

ลุ่มนํ้ายอ่ยท่ี4 (LB4) 

ลุ่มนํ้ายอ่ยท่ี5 (LB5) 

แม่นํ้าเลย 

แม่นํ้าโขง 

อ.ท่าล่ี 

อ.ภูเรือ 

อ.วงัสะพงุ 
อ.เอราวญั 

อ.นาดว้ง 

อ.หนองหิน 

อ.ภูหลวง 

อ.เมืองเลย 

อ.เชียงคาน 
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รูปที ่3.14  แสดงแผนภูมิการแบ่งพื้นท่ีลุ่มยอ่ยต่างๆ ในลุ่มนํ้าเลย  
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ตารางที ่3.5  แสดงลกัษณะทางกายภาพของสถานีท่ีศึกษาในแต่ล่ะสถานีของลุ่มนํ้าโขง 
 

ท่ี สถานี แม่นํ้า อาํเภอ จงัหวดั 
A 

(กม^2.) 
S 

L 
(กม.) 

Lc 
(กม.) 

SLLc /  
Qp 

(ลบม./
ว/ิมม.) 

Tp 
(ชม.) 

Qp/A 
 

1 KH.18 หว้ยโมง บา้นผอื อุดรธานี 1,309 0.0027 56.76 23.49 25,650.31 4.15  0.003 

2 KH.28A นํ้าเลย วงัสะพุง เลย 1,271 0.0014 126.51 36.62 125,921.31 36.72 24 0.029 

3 KH.58A นํ้าเลย เมือง เลย 3,093 0.0004 157.28 32.39 255,038.73 17.15 36 0.006 

4 KH.75 นํ้าหมนั ด่านซา้ย เลย 388 0.0155 57.10 19.10 8,773.04 1.10  0.003 

5 KH.77 นํ้าทบ วงัสะพุง เลย 142 0.0102 25.51 10.40 2,623.56 5.95 4 0.042 

6 KH.77A นํ้าทบ วงัสะพุง เลย 156 0.0102 27.79 10.89 2,991.81 2.65 12 0.017 

7 KH.78 นํ้าฮวย เมือง เลย 219 0.0010 43.25 25.37 34,308.16 2.26 24 0.010 

8 KH.79 หว้ยบงัอี หนองสูง มุกดาหาร 104 0.0019 23.75 12.73 6,918.66 3.72 5 0.036 

9 KH.84 หว้ยทราย คาํชะอี มุกดาหาร 46 0.0016 18.96 12.62 5,979.29 2.40 6 0.052 

10 KH.90 นํ้าพุง 
โคกศรี
สุพรรณ 

สกลนคร 861 0.0011 85.27 42.71 110,146.39 8.31 18 0.010 

11 KH.91 หว้ยชะโนด ธาตุพนม นครพนม 172 0.0014 26.08 10.57 7,270.62 1.77 24 0.010 
12 KH.93 นํ้าสงคราม บา้นดุง อุดรธานี 760 0.0007 85.10 33.32 110,729.18 2.70 42 0.004 
13 KH.94 นํ้าโสม นายงู อุดรธานี 854 0.0007 68.75 40.91 106,175.55 3.10 40 0.004 
14 KH.95 นํ้าสาน ภูเรือ เลย 3 52 0.0025 62.35 26.73 33,036.72 3.91 16 0.011 

 
 

 
 

รูปที ่3.15  กราฟความสมัพนัธ์ระหวา่ง pT  และอตัราส่วน SLLc /  
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รูปที ่3.16  กราฟความสมัพนัธ์ระหวา่ง AQp /  และ pT  
 

 
 

รูปที ่3.17  กราฟหน่ึงหน่วยนํ้าท่าท่ีไม่มีหน่วย (Dimensionless Unit Hydrograph) ของลุ่มนํ้าโขง 
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(ก) กราฟหน่ึงหน่วยนํ้าท่าของลุ่มนํ้ายอ่ย LB1 
 

 
 

(ข) กราฟหน่ึงหน่วยนํ้าท่าของลุ่มนํ้ายอ่ย LB2 
 

รูปที ่3.18  กราฟหน่ึงหน่วยนํ้าท่า ของจุดพิจารณาทั้ง 5 ลุ่มนํ้ายอ่ย 
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(ค) กราฟหน่ึงหน่วยนํ้าท่าของลุ่มนํ้ายอ่ย LB3 
 

 
 

(ง) กราฟหน่ึงหน่วยนํ้าท่าขงลุ่มนํ้ายอ่ย LB4 
 

รูปที ่3.18  กราฟหน่ึงหน่วยนํ้าท่า ของจุดพิจารณาทั้ง 5 ลุ่มนํ้ายอ่ย (ต่อ) 
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(จ) กราฟหน่ึงหน่วยนํ้าท่าของลุ่มนํ้ายอ่ย LB5 
 

รูปที ่3.18  กราฟหน่ึงหน่วยนํ้าท่า ของจุดพิจารณาทั้ง 5 ลุ่มนํ้ายอ่ย 
 
3.2.8   การวเิคราะห์พายุฝน 

ทาํการวิเคราะห์พายฝุน ประกอบดว้ยการวเิคราะห์แจกแจงความถ่ีปริมาณฝนสูงสุดสาํหรับช่วงเวลา 1 
วนั 2 วนั และ 3 วนั ของสถานีวดันํ้าฝนต่าง ๆ และการคาํนวณปริมาณฝนสูงสุดสาํหรับบริเวณจุด
พิจารณาของโครงการไดพ้ิจารณาเลือกใชส้ถานีวดันํ้ าฝน 18013 ซ่ึงตั้งอยูท่ี่ อาํเภอเมือง จงัหวดัเลย นาํ
ขอ้มูลนํ้าฝนของสถานีดงักล่าวมาหาปริมาณฝนสูงสุดรายปีสาํหรับช่วงเวลา 1, 2 และ 3 วนั และ
คาํนวณปริมาณฝนสูงสุด 1, 2 และ 3 วนั ท่ีคาบความถ่ีของการเกิดต่าง ๆ ผลการวิเคราะห์แสดงใน
ตารางท่ี 3.6  ในการคาํนวณปริมาณฝนใชก้าร ใชส้มการการประเมินค่าสมัประสิทธ์ิการเกิดนํ้าท่าจาก
ปริมาณนํ้าฝนของลุ่มนํ้าภาคตะวนัออกเฉียงเหนือในลุ่มนํ้าชี ท่ีสถานี E.29 พื้นท่ีรับนํ้า 949 ตาราง
กิโลเมตร ศึกษาโดย รัตนา, 2542 มีสมการความสมัพนัธ์ดงัน้ี  
 

กรณีฝนปกติ      996.26 0.1233RF(%)
1

OC    (R2 =   0.5793)   
  กรณีฝนตกหนกัต่อเน่ือง    045.31 0.1017RF(%)

2
OC    (R2 =   0.4821)   
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ตารางที ่3.6  ปริมาณฝนสูงสุด 1, 2 และ 3 วนั ท่ีคาบความถ่ีของการเกิดต่างๆ บริเวณพ้ืนท่ีศึกษา 
 

รอบปีการเกิดซํ้า ช่วงเวลาฝนตก 

(ปี) 1 วนั 2 วนั 3 วนั 

2 83.47 111.08 126.60 
5 110.14 150.99 171.84 

10 127.79 177.42 201.79 
25 150.10 210.81 239.64 

50 166.65 235.58 267.72 
100 183.08 260.16 295.59 

500 221.04 316.98 359.99 
1000 237.36 341.40 387.68 

 

3.2.9   การวเิคราะห์กราฟนํา้หลากสูงสุด 

ทาํการวิเคราะห์กราฟนํ้าหลากสูงสุดของของจุดพิจารณาทั้ง 5 ลุ่มนํ้ายอ่ย โดยมีขั้นตอนต่อไปน้ี 
 
1.   การวเิคราะห์ปริมาณฝนสูงสุด 
จากผลการวิเคราะห์ปริมาณฝนสูงสุดสาํหรับจุดพิจารณาท่ีมีช่วงเวลา 1วนั จะแบ่งปริมาณฝนสูงสุดใน
แต่ละวันออกแบบช่วง โดยมีช่วงเวลาเท่ากับช่วงเวลาของกราฟหน่ึงหน่วยนํ้ าท่า โดยใช้การ
แพร่กระจายรายชั่วโมงของปริมาณฝนสูงสุดจากสถานีวดันํ้ าฝนดัชนีท่ีมีการเก็บรวบรวมขอ้มูล
ปริมาณฝนแบบอตัโนมติั โดยการศึกษาคร้ังน้ีใชเ้ปอร์เซ็นตก์ารแพร่กระจายของฝนสูงสุด 1 วนั ท่ีคาบ
การเกิดซํ้ าต่างๆ จากผลการวิเคราะห์กราฟนํ้ าฝนจากสถานีวดันํ้ าฝนอตัโนมติั เน่ืองพื้นท่ีท่ีศึกษาไม่มี
ขอ้มูลกราฟนํ้ าฝนอตัโนมติั จึงประยุกต์ใช้กราฟนํ้ าฝนอตัโนมติัท่ีสถานีตรวจอากาศอาํเภอเมือง 
จงัหวดัเลย (รหสัสถานีวดันํ้าฝน 18013) แสดงในตารางท่ี 3.7 
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ตารางที ่3.7  เปอร์เซ็นตก์ารแพร่กระจายของฝนสูงสุด 1 วนั 
 

ช่วงเวลา (ชม.) เปอร์เซ็นตฝ์นสูงสุด 1 วนั ช่วงเวลา (ชม.) เปอร์เซ็นตฝ์นสูงสุด 1 วนั 

1 49.00 13 95.50 
2 62.00 14 96.00 

3 70.00 15 96.40 
4 76.00 16 97.00 

5 81.00 17 97.40 
6 84.20 18 97.80 

7 87.50 19 98.20 
8 89.70 20 98.80 

9 91.40 21 99.20 
10 93.00 22 99.60 

11 94.00 23 99.80 
12 95.00 24 100.00 

 
2.   การกาํหนดปริมาณฝนส่วนเกนิ 
การกาํหนดแฟคเตอร์เพื่อหาปริมาณฝนส่วนเกินท่ีจะเกิดเป็นนํ้ าท่าผวิดินแฟคเตอร์ สูญเสียปริมาณฝน 
กาํหนดให้มีค่า 20% ส่วนแฟคเตอร์ลดปริมาณฝนตามขนาดพ้ืนท่ีรับนํ้ าฝนไดก้าํหนดในคาบการเกิด
ดงัต่อไปน้ี 

 

คาบความถ่ีของการเกิด (ปี) 2 5 10 20 50 100 200 500 1000 

แฟคเตอร์ลดปริมาณฝนตาม
ขนาดพ้ืนท่ีรับนํ้าฝน 

0.62 0.64 0.653 0.666 0.682 0.694 0.706 0.722 0.735 

 
3.   การวเิคราะห์ปริมาณนํา้หลาก 
การประยุกต์กราฟหน่ึงหน่วยนํ้ าท่ากับปริมาณฝนส่วนเกินจะได้ปริมาณการไหลโดยตรง (Direct 
Runoff) และเม่ือนาํไปรวมกบัปริมาณการไหลพ้ืนฐาน (Base Flow) จะไดป้ริมาณการไหลทั้งหมด 
(Total Runoff) สาํหรับปริมาณการไหลพื้นฐานนั้นกาํหนดใหมี้ค่าแปรผนัตามขนาดปริมาณการไหล
สูงสุดของกราฟนํ้าหลาก ดงัสมการถดถอยต่อไปน้ี 
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       b
PB aQQ                      (3.5)

 เม่ือ 
  Qp คือ ปริมาณการไหลสูงสุดของกราฟนํ้าหลาก (ลบ.ม.ต่อวินาที) 
  QB คือ ปริมาณการไหลพื้นฐาน (ลบ.ม.ต่อวินาที)  
  a และ b คือ สมัประสิทธ์ิถดถอย  
 
จากผลการศึกษาโดย สราวธุ(2534)   พบวา่ปริมาณการไหลพื้นฐานของลุ่มนํ้าโขงมีความสมัพนัธ์ดงัน้ี 
 

     
1.13316 0.04541 PB QQ                (R = 0.76691)             (3.6) 

 
เม่ือนาํไปรวมกบักราฟนํ้ าหลากท่ีคาํนวณได ้ไปหาปริมาณการไหลทั้งหมด ในการศึกษาคร้ังน้ีได้
เลือกใชก้ารคาํนวณกราฟนํ้ าหลากสําหรับคาบความถ่ีของการเกิด 1,000 ปี เพื่อให้สอดคลอ้งกบั
เหตุการณ์นํ้าท่วมอาํเภอเมืองเลย ปี พ.ศ. 2545  จากนั้นนาํค่าปริมาณนํ้าหลากจากกราฟนํ้าหลากของจุด
พิจารณาทั้ง 5 ลุ่มนํ้ายอ่ย แสดงตาม รูปท่ี 3.19 (ก) – (จ) ไปใชใ้นการเป็นขอ้มูลอตัราการไหล (Inflow) 
เขา้ไปในโปรแกรม iRIC   

 

     
 

(ก) กราฟ LB1 
รูปที ่3.19  กราฟนํ้าหลาก (Flood Hydrograph) ของจุดพจิารณาทั้ง 5 ลุ่มนํ้ายอ่ย  
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(ข) กราฟนํ้าหลากของลุ่มนํ้ายอ่ย LB2 
 

       
 

(ค) กราฟนํ้าหลากของลุ่มนํ้ายอ่ย LB3 
 

รูปที ่3.19  กราฟนํ้าหลาก (Flood Hydrograph) ของจุดพจิารณาทั้ง 5 ลุ่มนํ้ายอ่ย (ต่อ) 
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(ง) กราฟนํ้าหลากของลุ่มนํ้ายอ่ย LB4 
 

          
 

(จ) กราฟนํ้าหลากของลุ่มนํ้ายอ่ย LB5 
 

รูปที ่3.19  กราฟนํ้าหลาก (Flood Hydrograph) ของจุดพจิารณาทั้ง 5 ลุ่มนํ้ายอ่ย (ต่อ) 
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3.2.10 การวเิคราะห์การเคลือ่นตวัของปริมาณนํา้นองสูงสุดผ่านอ่างเกบ็นํา้ 

ทาํการวิเคราะห์การเคล่ือนตวัของปริมาณนํ้าหลากสูงสุดผา่นอ่างเกบ็นํ้า (Reservoir Routing) คือ การ
คาํนวณหากราฟอตัราการไหลหลงัจากผา่นอ่างเกบ็นํ้า เพื่อวิเคราะห์ Flood surcharge โดยจะใช้
สมการต่อเน่ืองเป็นสมการพื้นฐาน 

 

       OI
t

S



          (3.7)

 
เม่ือ 
 S  คือ การเปล่ียนแปลงปริมาตรความจุของอ่างในระหวา่งช่วงเวลา t  

I   คือ ปริมาณการไหลเขา้เฉล่ียของนํ้านองในช่วงเวลา  t  
O   คือ ปริมาณการไหลออกเฉล่ียของนํ้านองในช่วงเวลา t  

 t  คือ ช่วงเวลาระหวา่ง t1 และ t2 หรือเรียกวา่ Routing Time Interval 
    (นิยมใชค่้าระหวา่ง 20 ถึง 40 % ของเวลาจากเร่ิมตน้ถึงเวลาเกิด Peak

 

   ของกราฟปริมาณนํ้าไหลเขา้ การศึกษาน้ีกาํหนดใหเ้ท่ากบั 1 ชม.)
 

 
ในการศึกษาการเคล่ือนตวัของกราฟนํ้ านองสูงสุดผา่นทางระบายนํ้ าลน้จะใชว้ิธีของ Goodrich ซ่ึงได้
ประยกุตส์มการต่อเน่ืองพื้นฐานใหอ้ยูใ่นรูป 
 

     












 1
12

1
212
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2 22
Q

tt
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tt

S                   (3.8)
 

 
เม่ือ 
  21, SS  คือ ปริมาตรความจุของอ่างเกบ็นํ้า ณ เวลา t1 และ t2 
  21,QQ  คือ ปริมาณการไหลออกเฉล่ียของนํ้าผา่น Spillway ท่ีเวลา t1 และ t2 
 
ในการวิเคราะห์การเคล่ือนตวัของปริมาณนํ้านองสูงสุดผา่นอ่างเก็บนํ้ า จาํนวน 4 แห่ง ตามแผนพฒันา
ลุ่มนํ้ าเลย ประกอบไปดว้ย โครงการอ่างเก็บนํ้ านํ้ าเลย โครงการอ่างเก็บนํ้ าห้วยนํ้ าฮวย  โครงการอ่าง
เกบ็นํ้าหว้ยนํ้าลาย และ โครงการอ่างเกบ็นํ้าหว้ยนํ้าทบ ไดก้าํหนดขนาดความยาวของทางระบายนํ้าลน้ 
(Spillway) คือ 105, 25 , 126 และ 70 ม. และกาํหนดสภาพเร่ิมตน้ในการคาํนวณใหมี้ระดบันํ้ าในอ่าง
เกบ็นํ้าเท่ากบัระดบัสนัของทางระบายนํ้ าลน้โดยขอ้มูลท่ีใชใ้นการคาํนวณประกอบดว้ย กราฟปริมาณ
นํ้ านองสูงสุดท่ีไหลเขา้อ่างเก็บนํ้ า ท่ีรอบปีการเกิดซํ้ า 1,000  ปี ซ่ึงเป็นผลการคาํนวณจากหัวขอ้การ
วิเคราะห์ปริมาณนํ้ านองสูงสุดโดยวิธีกราฟหน่ึงหน่วยนํ้ าท่า และอตัราการระบายนํ้ าผา่น Spillway 
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คาํนวณจากสมการท่ี (14) ผลการวิเคราะห์การเคล่ือนตวัของกราฟนํ้ านองสูงสุดของอ่างเก็บนํ้ า แสดง
ในรูปท่ี 3.20 (ก) – (ค) 
 

      
 

(ก) กราฟผลการวิเคราะห์ Reservoir Routing ของลุ่มนํ้ายอ่ย LB1 
 

         
 

(ข) กราฟผลการวิเคราะห์ Reservir Routing ของลุ่มนํ้ายอ่ย LB4 
 

รูปที ่3.20  ผลการวิเคราะห์ Reservoir Routing สาํหรับปริมาณนํ้านองสูงสุด 

Inflow 
Outflow 

Inflow 
Outflow 
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(ค) กราฟผลการวิเคราะห์ Reservoir Routing ของลุ่มนํ้ายอ่ย LB4 
 

รูปที ่3.20  ผลการวิเคราะห์ Reservoir Routing สาํหรับปริมาณนํ้านองสูงสุด (ต่อ) 
 

3.2.11 การดาํเนินการสร้างแบบจาํลอง 

เม่ือเตรียมขอ้มูลดงักล่าวไดค้รบถว้นแลว้ ดาํเนินการสร้างแบบจาํลองและนาํเขา้ขอ้มูล  ในแบบจาํลอง 
Nays2D Flood สาํหรับสภาพลุ่มนํ้ าเลย ในกรณีไม่มีอ่างเก็บนํ้ า และกรณีท่ีมีอ่างเก็บนํ้ าทั้ง 4 แห่ง ได้
ดงัรูปท่ี 3.21 ส่วนกรณีอ่ืน ๆ สามารถสร้างไดใ้นลกัษณะคลา้ย ๆ กนั แสดงในภาคผนวก ข 

 
3.2.12 การปรับเทยีบแบบจาํลอง (Calibration of Model) 
ในการปรับเทียบแบบจาํลอง โดยเลือกเหตุการณ์อุทกภยัปี พ.ศ. 2545 เปรียบเทียบผลการคาํนวณโดย
ใชโ้ปรแกรม Nays2D Flood กบัขอบเขตพื้นท่ีนํ้ าท่วมท่ีมีการรวบรวมขอ้มูลความเสียหายนํ้ าท่วมใน
อดีตท่ีผ่านมาจากหน่วยงานต่างๆ และจากการสํารวจคราบนํ้ าท่วม และเปรียบเทียบค่าระดบัผิวนํ้ า 
(Water Surface Elevation) จากผลการคาํนวณ กบัสถิติค่าระดบัผวินํ้ าท่ีไดจ้ากสถานีวดันํ้ า KH58A 
ของกรมชลประทาน ไดแ้สดงไวใ้นรูปท่ี 3.22 ,รูปท่ี 3.23 และ รูปท่ี 3.24  ท่ีเกบ็รวบรวมขอ้มูลไว ้ เพื่อ
ตรวจสอบความน่าเช่ือถือของแบบจาํลอง โดยตวัแปรสาํคญัในการปรับแกก้ารปรับเทียบแบบจาํลอง
คือค่าสมัประสิทธ์ิความขรุขระของ Manning (n) การเลือกใชค่้า n ข้ึนอยูก่บัลกัษณะของผวิทางนํ้ าเปิด
ดงัแสดงตามตารางท่ี 3.8 

Inflow 
Outflow 
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รูปที ่3.21  รูปแบบการดาํเนินการสร้างแบบจาํลอง 
 

 
 

รูปที ่3.22  แสดงสภาพนํ้าท่วมปี2545 ในเขตเทศบาลเมืองเลย ท่ีบริเวณสถานีวดันํ้า KH.58A 
 
 
 
 
 
 

ระดบัตล่ิงซา้ย (ฝ่ังตวัเมือง) +239.10 ม(รทก.) 



   69 
 

 

 
 

รูปที ่3.23  แสดงขอบเขตพื้นท่ีศึกษาและท่ีตั้งของสถานีวดันํ้าท่า KH.58A 

 

สัญลกัษณ์ 
 สถานีวดันํ้าฝน 
 สถานีวดันํ้าท่า 
 ลาํนํ้าธรรมชาติ 
 ท่ีตั้งจงัหวดั 
 ท่ีตั้งอาํเภอ 
 ขอบเขตลุ่มนํ้าเลย 
 สถานีอุตุอุทกนิยมวทิยา 
 อ่างเกบ็นํ้าขนาดกลางตามแผนงาน 

อ่างเกบ็นํ้านํ้ าเลย 

อ่างเกบ็นํ้าหว้ยนํ้าทบ 

อ่างเกบ็นํ้าหว้ยนํ้าฮวย 

อ่างเกบ็นํ้าหว้ยนํ้าลาย 

ขอบเขตพื้นท่ีศึกษา 

ท่ีตั้งสถานีวดันํ้าท่า KH.58A 
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ผวินํ้ าขณะสาํรวจ วนัทีท่าํการสาํรวจ

240.440 ม.(รทก.) 229.000 ม.(รทก.) 229.250 ม.(รทก.) 239.100 ม.(รทก.) 238.200 ม.(รทก.) 241.12 ม.(รทก.) 6  ก.ย. 2545

หมุดหลกัฐาน ศูนย์เสาระดบั ระดบัทอ้งนํ้ า ตล่ิงฝ่ังซา้ย ตล่ิงฝ่ังขวา
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รูปที ่3.24  แสดงระดบัพื้นท่ีในเขตเทศบาลเมืองเลย และรูปตดัลาํนํ้ าเลยสถานีวดันํ้า KH.58A 
 
 
 
 
 
 
 
 
 
 
 

ระดบันํ้า +241.12 ม(รทก.) 
 +241.00  ถนนมะลิ

 +240.20  ถนนเชียงคาน 

 +239.41  ถนนเจริญรัตน ์

 +236.20  บา้นล่าง  +238.00  สวนกีฬา 

ระดบันํ้าท่วมวนัท่ี 6 ก.ย. 2545  
     ( +241.12 ม.รทก. ) 
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ตารางที ่3.8  สมัประสิทธ์ิความขรุขระของ Manning 
 

ลกัษณะของผวิทางนํา้เปิด ตํ่าสุด เฉลีย่ สูงสุด 

A. ทางนํ้าเปิดธรรมชาติ 
    1. ทอ้งนํ้าค่อนขา้งเรียบ แนวตรง ระดบันํ้าลึก 
    2. ไหลชา้เน่ืองจากทอ้งนํ้าลึกเป็นช่วงๆ 
    3. ทอ้งนํ้ามีหิน ขา้งๆมีวชัพืชรก 
    4. ทางนํ้ ามีความชนั ทอ้งนํ้ ามีกรวด ดา้นขา้งปกคลุม
ดว้ยวชัพืช 
B. ฝ่ังแม่นํ้ าท่ีมีนํ้ าท่วมถึง (Flood plains) 
    1. ทุ่งหญา้ไม่สูงนกั 
    2. ป่าละเมาะ,หญา้รก 
    3. ไมพุ้ม่เต้ีย 
    4. ตน้ไมห้นาแน่น 
C. ทางนํ้าเปิดดินขดุ 
    1. แนวตรง หนา้ตดัสมํ่าเสมอ 
    2. มีกรวดบา้ง 
    3. เตม็ไปดว้ยหญา้ปกคลุม 
    4. ขดุในหินและแต่งผวิค่อนขา้งเรียบ 
D. ทางนํ้าเปิดดาดผวิ หรือแต่งผวิดว้ยวสัดุใดๆ 
    1. ซีเมนตผ์วิเรียบ 
    2. เหลก็ลอนลูกฟกู 
    3. เหลก็ผวิเรียบไม่ทาสี 
    4. เหลก็ผวิเรียบทาสี 
    5. เหลก็มีหมุดย ํ้า 
    6. เหลก็หล่อเคลือบผวิ 
    7. คอนกรีตขดัผวิเรียบ 
    8. คอนกรีตขดัผวิหยาบ 
    9. คอนกรีตดา้นขา้งมีกรวดท่ีทอ้งคลอง 
    10. ดาดคอนกรีตทอ้งคลองดา้นขา้งเรียงหิน 
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